
Tatvic Analytics Pvt. Ltd. 1 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

User Manual for Google Analytics 

Enhanced Ecommerce Pro by Tatvic for 

Magento2 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://www.tatvic.com/


Tatvic Analytics Pvt. Ltd. 2 

 

 

 

 

 

 

Table of contents 

 

1. Introduction 3 

2. Features 5 

3. Installation Guide 6 

3.1 Extension Installation Methods 6 

 

3.1.1 Install the extension using setup wizard 6 

3.1.2 Install the extension manually 11 

3.2 Configure the extension in your Magneto admin panel 12 

 

General settings 13 

3.3 Configuration in Google analytics 15 

4. Points to ponder 16 

        4.1 Support section 17 

https://www.tatvic.com/


Tatvic Analytics Pvt. Ltd. 3 

 

 
1. Introduction 

About Google Analytics: It is a free web analytics service offered by Google which offers site 

owners the meaningful insights into the browsing behavior of the users. In Google Analytics, reports are 

categorized into 4 sections: 1. Audience 2. Acquisition 3. Behavior 4. Conversions. 

1. Audience: The audience reports in Google Analytics provide insight into characteristics of users 

who have visited your site. Audiences in Analytics are users that you group together based on 

any combination of attributes that is meaningful to your business. For example, you might want 

to create an audience of users who have purchased in last 12 months but not in last 2 months. 

You can then remarket to this audience using Google Ads. 

 

2. Acquisition: The Acquisition report in Google Analytics helps you in discovering how users 

arrive at your website. You can use this reports to understand whether users are coming from the 

organic search or paid campaigns or from any other channels. This also tells you how your 

different channels are performing in terms of the quality traffic on your store. 

 

3. Behavior: The Behavior reports in Google Analytics helps you in understanding how users are 

interacting with your store pages, which pages are viewed the most and which pages are making 

your users leave your store. These insights help you in making sound technical decisions to 

improve on your store’s UX or to better your merchandizing efforts. 

 

4. Conversions: This is the most important feature for the ecommerce businesses globally as it 

helps you understand your ecommerce business holistically. Ecommerce segment under 

conversions tab in Google Analytics provides you 9 enhanced ecommerce reports as explained 

below: 

 Overview: The Overview report lets you see the overall state of your business, and 

provides three categories of related metrics: 

1. Revenue and Conversion Rate 

2. Transactions 

3. Marketing 

 

 Shopping Behavior Analysis: The Shopping behavior analysis report lets you see the 

number of sessions that included each stage of your purchase funnel. It gives you holistic 

view on which funnel step your site visitors are leaving you the most. The funnel steps 

are sessions for the site visit to product detailed views to cart abandonment to checkout 

abandonment to final purchase. This helps you in identifying the strengths and 

weaknesses in your purchase funnel.  
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 Checkout Behavior Analysis: The Checkout Behavior Analysis report lets you see how 

successfully your users moved through your checkout process. The checkout-funnel 

visualization illustrates how many users moved on from one step to the next, how many 

abandoned the process at each step, and how many entered the process at each step.  

 

 Product Performance: The product performance report lets you see how your products 

are performing from two difference points of view: 

o Summary: Product performance in terms of revenue, price, and quantity. 

Includes two of the Shopping Behavior metrics. 

o Shopping Behavior: Product performance in terms of user engagement with your 

products (e.g., viewing products and details, adding and removing products from 

carts, completing checkouts etc.) You can also have access to 2 important metrics 

such as Cart-To-Detail rate and Buy-To-Detail rate. 

 

 Sales Performance: The Sales performance reports in Google Analytics lets you 

evaluate your sales data by either of 2 primary dimensions: 

o Transaction 

o Date 

The Sales performance report includes the metrics like revenue, shipping, tax, refund 

amount, quantity, discount etc. 

 Product List Performance: Product lists represent a logical grouping of your product on 

your store. The typical product lists for an ecommerce store are Category page, related 

products block, similar products block, any cross sell or up sell blocks, search pages etc. 

This product performance report in Google Analytics lets you see how a particular 

product list on your store is performing with the metrics such as product list views, 

product list clicks or product list CTR. This helps you in better merchandizing your store 

for higher conversion rate. 

 Marketing:  This report lets you see performance of your internal promotion, order 

coupon and product coupon. 

 

5. Custom Dimensions and Metrics: One of the most important feature of Google Analytics is 

creating custom dimensions and metrics. In all of the reports mentioned above Google Analytics 

allows sending specific data points from your store. For example, on the order confirmation page 

the required data points that have to be pushed are: id, affiliation, revenue, tax, shipping and 

coupon. Now say you want to see sales performance report based on the user role or based on the 

week day or based on the city, then you can create custom dimensions for user role or for week 

day or for city in pass that when the order confirmation page is called along with the necessary 

data points asked by Google Analytics. We have created 20 such custom dimensions and metrics 

in our extension. You can find the full list here. 

https://www.tatvic.com/
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6. Advanced Tracking: Apart from the reports mentioned above Google Analytics also has 

advanced features like user id tracking which enables you in cross device tracking, client id 

tracking which helps you in creating audiences in Google Ads, content grouping from which you 

can create logical groups for your store like groups based on brands or categories, form field 

tracking which helps you see the tracking on checkout forms, IP anonymization, opt out and 

more. Our extension sets all these features in a single click on your store. 

 

About Google Analytics Enhanced Ecommerce Pro by Tatvic: Our Magento2 Extension allows 

you to integrate your Magento2 store and Google analytics for Enhanced Ecommerce reports and site 

analytics. You can track the user behavior across your Ecommerce store starting from product views to 

thank you page. 

 
Below are the listed features of the extension: 

 

2. Features 

1. Quick and easy configuration – 5 min set up 

2. Audience, Behavior and Acquisition tracking in GA 

3. Enhanced ecommerce reports 

a. Overview report 

b. Shopping behavior analysis 

c. Checkout behavior analysis 

d. Sales performance report 

e. Product performance report 

f. Product list performance report 

g. Internal promotion report 

h. Order coupon report 

i. Product coupon report 

j. Affiliate report 

4. IP anonymization 

5. Opt out feature 

6. User id tracking 

7. Client id tracking 

8. Content grouping 

9. Form field tracking 

10. Product refund tracking in GA 

11. Custom Dimensions: 

 Payment Method: Get insights into which Payment method (PayPal, credit card, etc.) is 

most popular for your store, which generates higher AOV and Transactions. 

 Shipping Method: Integrates the Shipping Method data directly into your GA. It Helps you 

learn about product demand using insights on Shipping Methods. 

 Client ID: Fetch GA Client Id from your store. 

12.  Custom development specifically catering to your requirements. Contact us at 

analytics2@tatvic.com to discuss on your custom requirements. 

https://www.tatvic.com/
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3. Installation Guide 

Below is the quick installation guide to configure our extension in your Magento2 store.  

 

3.1 Extension Installation Methods 
 

3.1.1 Install the extension using setup wizard: 

 

1. Log in to the Admin of your Magento2 store as a user with full administrator rights. 

To ensure the fastest installation, verify that Cron is configured to run every minute. 

2. On the Admin sidebar, go to System > Tools > Web Setup Wizard. 

Web Setup Wizard 

3. Click Extension Manager, then click Sign In. 

4. When prompted, paste the Public Access Key and Private Access Key from your Marketplace 

account. If you need your access keys, click the Magento Marketplace account page link, locate 

the keys from the Access keys page, and add them to the Admin page then click on ‘Submit’. 

Paste Access Keys 

https://www.tatvic.com/
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It will take a few minutes to generate the summary and list of all available updates, recently 

purchased extensions, and currently installed extensions and sample data. 

Summary of extensions and information 

5. Under Extensions Ready to Install, click Review and Install to see a list of all available 

extensions. 

6. In the Latest version column, choose the version that you want to install. Then in 

the Action column, click Install. 

Extensions Grid 

7. Complete the following steps. 

 

https://www.tatvic.com/
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Step 1: Readiness Check 

Before the installation begins, run a readiness check to verify compatibility for your store environment. 

1. Click Start Readiness Check. 

 

The progress indicator tracks process. 

Start Readiness Check 

2. When the Readiness Check completes successfully, click Next. 

 

Readiness Check Complete 

https://www.tatvic.com/
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Step 2: Create Backup 

Your store will be put in Maintenance Mode while the backup is created. By default, the backup 

includes the code, media, and the database. 

1. Clear the checkbox of any item that you do not want to include in the backup. 

Backup Options 

2. Click Create Backup. Then, wait a few minutes for the backup to complete. 

 

Locations and information are posted for each backup. 

Backup Complete 

You can see the path to the backup file at the bottom of the report. 

3. Click Next. 

https://www.tatvic.com/
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Step 3: Extension Install 

Your store will be taken offline to protect shoppers during the installation. 

1. When you are ready to begin, click Install. 

 

Depending on your cron setting, it might take some time for the installation to complete. The page 

shows the current status, and you can track its progress in the Console Log. The Success page 

appears when the process is complete. 

Installation Complete 

2. When complete, click Back to Setup Tool. Then, click System Configuration. 

 

3. In the upper-right corner, click the Reset link to log out. 

Step 4: Flush Caches 

1. Log in to the Admin of your store. 

2. Do one of the following: 

o Click the Cache Management link in the message above the workspace. 

o On the Admin sidebar, go to System > Tools > Cache Management. 

3. For each cache to be refreshed, select the checkbox at the beginning of the row. 

4. Set Actions to Refresh and click Submit. 

 

5. The extension will be installed and you can verify the same at Stores->Configuration when you 

are logged in as an admin of the store. 

 

6. Next step is configure our extension by following the instructions mentioned in the 3.2 and 3.3 

sections. 

https://www.tatvic.com/
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Cache Management 

 

3.1.2 Install the extension manually: 

 
1. Login to Magento2 with ssh 

2. Enter the command ssh root@yourIP 

3. Enter password 

4. Extract extension folder to app/code folder 

5. run the below commands in project root path 

a) php bin/magento setup:upgrade   

b) php bin/magento setup:di:compile   

c) php bin/magento setup:static-content:deploy -f   

d) chmod -R 777 generated/ pub/ var/   

6. The extension will be installed and you can verify the same at Store->Configuration. 

7. Next step is configure our extension by following the instructions mentioned in the 3.2 and 3.3 

sections. 

https://www.tatvic.com/
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3.2 Configure the extension in your Magento admin panel 
 

● Log-in to your Magento store’s admin panel. 

● Click on ‘STORES’ to configure the extension. 

● Under the configuration section, click on Google Analytics Enhanced Ecommerce - Pro 

Extension to configure the same. 

● Enter the extension’s access key under the ‘Magento Marketplace Access Key’ section. 

 

 

 

Below is more information about the extension’s general settings: 

https://www.tatvic.com/
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General settings: 
 

 

a. Google Analytics Enhance Ecommerce Pro Extension: Use this feature to enable or 

disable Google analytics enhance ecommerce pro tracking. 

b. Email ID: Add your email address so that you can receive the enhancement updates 

for our extension. 

c. Google Analytics ID: Enter your Google Analytics ID here. Your Google Analytics 

ID Code should look like “UA-XXXXXXXX-X”. Check out how to find your Google 

Analytics ID. 

https://www.tatvic.com/
https://support.google.com/analytics/answer/1008080#trackingID
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https://support.google.com/analytics/answer/1008080#trackingID
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d. Enable Display Feature: Use this feature to enable the advertising features extension 

or enable remarketing and advertising reporting features in analytics. 

e. Enable IP Anonymization: Use this feature to anonymize (or stop collecting) the I.P 

address of your users in Google analytics. Be in legal compliance by using I.P 

Anonymization which is important for EU countries. 

f. Enable User ID Tracking: Use this feature to get more accurate count & better 

analyze the signed-in user experience. To start using this feature, please create a new 

view in GA and follow the step1 of this wizard. 

g. Enable Client ID Tracking: Use this feature to collect client id (for remarketing) 

from your website into your GA account. To use this feature check this option and rest 

our extension will take care. Refer the step 2 of this wizard to know more about it. 

a. Enable Google Analytics Opt Out: Use this feature to provide website visitors the 

ability to prevent their data from being used by Google Analytics As per the GDPR 

compliance. 

h. GA Authentication Token: Click on the “Click Here” to get the token then copy paste 

the token in the GA Authentication Token field to authenticate it. The purpose of this 

authentication step is to see the product refund data in your GA. 

 

Once all the information in our Extension’s setting is set, click on “Save Config” to save the 

Changes. 

 

 

 

 

 
 

 

https://www.tatvic.com/
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   3.3    Configuration in Google analytics 

Follow the below bullet points to configure Enhanced Ecommerce in your GA: 

● In your Analytics account, browse to: Your Store’s Account -> Selected View -> Ecommerce 

Settings. 

● Under the Ecommerce settings, turn the status as “On” for ‘Enable Ecommerce’ as well 

as for ‘Enable Enhanced Ecommerce Reporting’. 
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Label the checkout funnel steps under the ‘Checkout Labelling’ as below: 

○ Step 1: Login 

○ Step 2: Billing 

○ Step 3: Shipping 

○ Step 4: Shipping Method 

○ Step 5: Payment 

○ Step 6: Review 

 

Once you complete configuring the above steps, your GA is ready to receive the data sent via our 

extension from your store. 
 
 

4. Points to Ponder 

 
● Currently this extension supports Magento standard checkout steps only. If you have 

single page checkout you shall not see all the data in the Checkout Behavior Report. 

● Doesn’t support the following features out of the box: 

○ Product types other than Simple Product 

○ Category Filters 

○ Auto Product Loading Using AJAX 
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○ Can't use your GTM with our extension (this feature is available with the 

Premium Version of our extension) 

○ OneStep checkout page (We are providing customization support for this 

extension) 

 
In case of any issues or queries regarding the installation or analytics data, please get in 

touch with us at analytics2@tatvic.com 

 

4.1 Support section: Below are all the relevant supporting links. 

 

 Setup Wizard 

 Support 

 Privacy Policy 

 
For any custom requirement related to our products and any marketing technology please  

Contact us at analytics2@tatvic.com 

 

We at Tatvic empowers Marketing Analytics for Unicorns, Fortune 500 companies and other 

Digital Giants. Please visit our website to know more about us. 

 

 

 

Thank You 

https://www.tatvic.com/
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